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News In Preview

This newsletter's Q and A section describes the workings of  the internal BJT base, collector, and emitter 
node expressions when used to plot a waveform.  The Easily Overlooked Feature section describes the 
use of  the Envelope command to graphically display plot variations of  any Monte Carlo or stepped 
simulation.

The first article describes the use of  the optimizer capability in a Dynamic DC analysis.  It uses the 
optimizer to set the current of  a Widlar current source.

The second article describes an ideal peak detector macro which can operate with both positive peak 
and negative peak detection.

The third article describes how to assign multiple shapes to a component and how to use the shape 
groups to invoke the shapes in the schematic.
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Book Recommendations

General SPICE
• Computer-Aided Circuit Analysis Using SPICE, Walter Banzhaf, Prentice Hall 1989.
 ISBN# 0-13-162579-9

• Macromodeling with SPICE, Connelly and Choi, Prentice Hall 1992. ISBN# 0-13-544941-3

• Inside SPICE-Overcoming the Obstacles of  Circuit Simulation, Ron Kielkowski, 
  McGraw-Hill, First Edition, 1993. ISBN# 0-07-911525-X

• The SPICE Book, Andrei Vladimirescu, John Wiley & Sons, Inc., First Edition, 1994.
 ISBN# 0-471-60926-9 

MOSFET Modeling
• MOSFET Models for SPICE Simulation, William Liu, Including BSIM3v3 and BSIM4, Wiley-Interscience, 
First Edition, ISBN# 0-471-39697-4

VLSI Design
• Introduction to VLSI Circuits and Systems, John P. Uyemura, John Wiley & Sons Inc, First Edition, 
 2002 ISBN# 0-471-12704-3

Micro-Cap - Czech
• Resime Elektronicke Obvody, Dalibor Biolek, BEN, First Edition, 2004. ISBN# 80-7300-125-X

Micro-Cap - German
• Schaltungen erfolgreich simulieren mit Micro-Cap V, Walter Gunther, Franzis', First Edition, 1997. ISBN# 
3-7723-4662-6

Micro-Cap - Finnish
• Elektroniikkasimulaattori, Timo Haiko, Werner Soderstrom Osakeyhtio, 2002. ISBN# ISBN 951-0-
25672-2 

Design
• Microelectronic Circuits High Performance Audio Power Amplifiers, Ben Duncan, Newnes, First Edition, 
 1996. ISBN# 0-7506-2629-1

• Microelectronic Circuits, Adel Sedra, Kenneth Smith, Fourth Edition, Oxford, 1998

High Power Electronics
• Power Electronics, Mohan, Undeland, Robbins, Second Edition, 1995. ISBN# 0-471-58408-8

• Modern Power Electronics, Trzynadlowski, 1998. ISBN# 0-471-15303-6
                                                
Switched-Mode Power Supply Simulation 
• SMPS Simulation with SPICE 3, Steven M. Sandler, McGraw Hill, First Edition, 1997.
 ISBN# 0-07-913227-8 

• Switch-Mode Power Supply SPICE Simulation Cookbook, Christophe Basso, McGraw-Hill 2001. This book 
describes many of  the SMPS models supplied with Micro-Cap. 
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Micro-Cap Questions and Answers

Question:  I am plotting the voltage expression V(Q2_EMITTER) in my simulation but it does not 
produce the emitter voltage for the Q2 transistor that I expect.  When I plot the voltage using the 
node number at the emitter, the waveform looks correct.  Why aren't these two expressions match-
ing?

Answer:  There are three voltage expressions that may be available for any BJT transistor in order to 
plot the internal collector, emitter, and base nodes of  the device.  The expressions take the form of:

V(Part_Emitter) 
V(Part_Base)
V(Part_Collector)

where Part is the PART attribute name of  the transistor.  For example, if  the PART attribute of  the 
transistor has been defined as Q3, then the expressions would be:

V(Q3_Emitter) 
V(Q3_Base)
V(Q3_Collector)

These expressions appear when you right click in the Y Expression field to invoke the Variables list.  
They are available within the Variables / Node Voltage section.

Note that the key point to these expressions is that they plot the internal nodes of  the transistor.  
These expressions are only available if  the corresponding lead resistance (RB, RC, or RE) has been 
defined in the BJT model statement.  In your case, the V(Q2_EMITTER) would produce a value 
equivalent to the voltage at the emitter node in the schematic minus the voltage drop across the RE 
resistor for the Q2 transistor.
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Fig. 1 - Envelope command used on a Monte Carlo analysis

Easily Overlooked Features

This section is designed to highlight one or two features per issue that may be overlooked among all 
the capabilities of  Micro-Cap.

Envelope command
In some simulations, it can be quite useful to view the spread of  waveforms rather than each individ-
ual waveform.  This is particularly true in many Monte Carlo simulations where the range of  results 
can be more important than an individual run in the analysis.  Micro-Cap has an Envelope command 
available under the Scope menu that creates a polygon which will encompass all of  the branches of  
a Monte Carlo or stepped run.  This command provides a simple way to graphically capture the plot 
variation.  The plot below displays the effect of  the Envelope command on a Monte Carlo simula-
tion in AC analysis.

The Envelope command is available once the simulation has finished.  It creates a closed polygon in 
the analysis plot that spans the high and low values at each data point.  Once created, the polygon 
is a graphic object in the analysis and can be deleted in the same manner as other graphic objects by 
selecting it and hitting Delete.

The polygon does not adjust with future runs so to update the envelope for a new simulation, the 
old polygon would need to be deleted and then the Envelope command would need to be invoked 
again.
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Optimization in Dynamic DC

The optimizer available within Micro-Cap provides a method to systematically modify component 
parameters to maximize, minimize, or equate a chosen function of  the circuit.  The optimizer is 
available within all analysis modes.  In transient, AC, and DC analysis, performance functions are 
used as the measurement criteria.  In Dynamic DC, since the analysis calculates just a single data 
point, circuit variables such as the voltage at a node or the current through a resistor can be opti-
mized directly.  This is very useful for optimizing a circuit to run at a desired bias point.  This article 
will describe the use of  the optimizer in Dynamic DC by optimizing a current in a Widlar current 
source circuit.

Fig. 2 - Widlar current source

The Widlar current source appears in the figure above.  The Widlar current source is used to main-
tain a small current in an integrated circuit in the place of  a large resistor since it will occupy a much 
smaller area of  the chip.  The two BJTs, Q1 and Q2, are matched transistors.  The approximate cur-
rent that this source produces at the collector of  Q2 is defined by the following formula:

IC(Q2) = (VT/R3) * ln(IC(Q1)/IC(Q2))

The above equation is nonlinear and requires an iterative process to calculate the value of  the R3 
resistor needed to produce the desired collector current at Q2.  Rather than going through the te-
dious iterative process manually, the optimizer available in Dynamic DC analysis can provide a quick 
answer to what resistance value is needed.

Dynamic DC analysis calculates the DC bias point of  the circuit and can display the DC voltage, 
current, power, and device conditions on the schematic.  The Dynamic DC current calculations for 
the Widlar current source using an emitter resistor with a value of  11.5kohms are shown in Figure 3.  
With this emitter resistance, the current source generates a current of  10.3uA.
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Fig. 3 - Original Widlar current source

Fig. 4 - Dynamic DC Optimizer dialog box

Suppose that the specifications of  the circuit require the current source to generate 12uA instead.  
To calculate the new emitter resistance, the Optimize command can be invoked from the Dynamic 
DC menu.  The Optimizer dialog box is displayed below:
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Fig. 5 - Optimized Widlar current source

The Find section of  the Optimizer dialog box defines the parameters to be optimized.  In this case, 
the resistance of  the R3 resistor will be optimized within the range of  1kohms to 20kohms.  The 
That section defines the optimizing criteria to use to find the optimal values of  the Find parameters.  
For this example, the single criteria is to have the current through the R1 resistor, which is equivalent 
to the collector current in the Q2 transistor, equate to 12uA.  In plain English, the optimizer is find-
ing the R3 resistance needed to generate 12uA at the Q2 collector.  Clicking the Optimize button 
initiates the optimization process.  The optimized values will be displayed in the dialog box.  If  the 
values look good, clicking the Apply button modifies the circuit with the optimized parameters.  To 
generate 12uA, the optimizer finds that the Widlar current source needs its emitter resistor set to 
9.57kohms.  The schematic below displays the Dynamic DC current calculations with the optimized 
resistance value.



�

Peak Detector Macro

Peak detector circuits are used within many types of  receivers.  A simple peak detector is created 
from a diode and a parallel resistor-capacitor combination to store the peak voltage.  Depending on 
the RC time constant, this configuration can encounter significant droop error.  A behavioral model 
of  an ideal peak detector can eliminate this droop error for simulation purposes.  The macro circuit 
below shows one method for creating an ideal peak detector.

Fig. 6 - Peak Detector macro

The peak detector macro has a single parameter passed through to it.  The Type parameter defines 
whether the detector will store positive peaks or negative peaks.  When Type is set to a value of  1, 
the detector will be a positive peak detector.  When Type is set to a value of  2, the detector will be a 
negative peak detector.

The macro circuit consists of  just two components.  The resistor is present to ensure that there is 
a DC path to ground at the input of  the macro.  The Sample and Hold source provides all of  the 
functionality of  the detector.  The Sample and Hold source has its attributes defined as follows:

INPUT EXPR = V(In)
SAMPLE EXPR = TypeExp

In the Text page of  the macro schematic, the following If  statement has been entered to define the 
TypeExp variable:

.if  Type==2

.define TypeExp V(In) < V(Out)

.else

.define TypeExp V(In) > V(Out)

.endif
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Fig. 7 - Peak Detector analysis

If  the Type parameter is set to 2, then the first define statement is used to define the TypeExp vari-
able, otherwise the second define statement is used.  Since the SAMPLE EXPR is defined for the 
Sample and Hold source, the source will operate in track and hold mode.  For the positive peak de-
tector mode, when the voltage at node In is greater than the voltage at node Out, TypeExp evaluates 
to true, and the source will track the voltage at node In.  When the voltage at node In falls below 
that of  node Out, TypeExp evaluates to false, and the source maintains its last sampled value which 
will be the highest value of  V(In) up to that point of  the simulation.  The negative peak detector op-
erates in a similar manner except that it samples the input waveform when V(In) is less than V(Out), 
so that it always maintains the lowest value of  the input.

A simple test circuit was created that sums a one volt, 100kHz sine source with a one volt, 1MHz 
sine source.  This summed waveform is then fed into the input of  both a positive peak detector and 
a negative peak detector.  The resulting transient analysis is shown below.

The V(In) expression plots the sum of  the two sine sources.  The V(OutP) expression plots the out-
put voltage of  the positive peak detector, and the V(OutN) expression plots the output voltage of  
the negative peak detector.  It is a simple procedure, using Cursor mode, to see that the positive and 
negative peaks of  the input waveform are at 1.988V and -1.988V respectively.
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Using Multiple Shapes and Shape Groups

Each component within the component library can have multiple shapes assigned to it for use in the 
schematic.  Whenever a shape is assigned to a component, a corresponding shape group is linked to 
the newly assigned shape.  A shape group typically contains similar groupings of  shapes for multiple 
components.  In the schematic, the shapes of  the components can be changed by editing the SHAPE-
GROUP attribute of  the component.  The advantage of  using shape groups in modifying the com-
ponent in the schematic is that using the shape group method allows the changing of  components en 
masse.  There are five shape groups that have been created with the standard distributed component 
library of  Micro-Cap.  They are as follows:

Main - This group is the default group for Micro-Cap.  Every component has a shape assigned to it 
within this group.
DeMorgan - This group contains the DeMorgan equivalent gate symbols for many of  the basic digital 
primitives.
Electrolytic - This group contains an electrolytic shape for the capacitor component.
Euro - This group contains common European shapes for many of  the active and passive devices.
Polarity - This group contains symbols that display the polarity for the capacitor and resistor compo-
nents.

An individual component can have any number of  Shape Group:Shape pairs assigned to it.  For ex-
ample, the default settings of  the resistor have the following pairs:

Main:Resistor
Euro:Resistor_Euro
Polarity:Respolar

Setting the SHAPEGROUP attribute for a resistor to Euro will cause that specific resistor to use the 
Resistor_Euro shape in the schematic.

Assigning multiple shapes to a component
All shapes available within Micro-Cap are created in the Shape Editor which is available under the 
Windows menu.  At this point in the article, the assumption is that any shapes to be assigned have 
already been created in the Shape Editor.

Shapes are assigned to components in the Component Editor which is available under the Windows 
menu.  When a component is selected in the tree on the right hand side of  the Component Editor, 
all of  its general properties are available for editing.  The Shape entry for each component has two 
fields.  The left field defines the shape group name, and the right field defines the actual shape.  Every 
component will contain a shape group called Main.  Components that use just a single shape must have 
that shape assigned within the Main group.

As an example of  adding a shape to a component, the Var_resist shape will be assigned to the Resistor 
component.  The Var_resist shape is a symbol of  a variable resistor.  The first step in assigning this 
shape is to select the Resistor component from the Analog Primitives / Passive Components section 
of  the component tree.  Next, click on the left hand Shape field which will drop down a list of  shape 
groups that are currently defined for the resistor.  At the top of  this list is the entry <Edit List...>.  
Click on this entry, and the following dialog box is invoked.
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Fig. 8 - Shape Group - Name dialog box

The top section shows the existing Shape Group:Shape pairs for the resistor.  Since the Main shape 
group must be defined for every component, it is not available in this list.  Existing pairs can be deleted 
by selecting them in the list and then clicking the Delete button.  The bottom section provides the 
capability to create new Shape Group:Shape pairs for the selected component.

Shape Group:  This field defines the name of  the shape group to be assigned.  Existing shape groups 
can be selected by clicking the drop down arrow to the right of  the field.  If  a new shape group is to 
be created, just type in the new name in the field.

Shape Name:  This field defines the actual shape to be assigned.  Clicking in the field provides a list 
of  all of  the available shapes.

Save:  Once a shape group and a shape name have been defined, clicking Save assigns that pair to the 
component.

For this example, a new shape group will be created.  The name VarComp is typed directly into the Shape 
Group field.  Then the Shape Name field is clicked and Var_resist is selected from the list.  Clicking 
the Save button adds this pair into the list in the top section.  Click OK to add this pair to the resistor 
component.  The new shape will now be shown in the Component Editor.

Note that all shapes assigned to a component should have their connections in the same locations.  Moving the pins for 
one shape will move them for all of  the component's shapes, as the pin locations are constant from one shape to another 
for a component.  Create any new shapes so that they use the existing pin locations for the component.

Closing the Component Editor and saving when prompted now makes this shape available to use with 
any resistor.

A single instance of  a resistor in the schematic can be changed to use this shape, or the shape group 
VarComp can be given the highest priority in a schematic so that the default shape for the resistor is 
Var_resist.
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Modifying a single component
To modify a single instance of  the component, simply change the SHAPEGROUP attribute of  the 
device in the Attribute dialog box.  For example, double click on an existing resistor to invoke the At-
tribute dialog box.  Highlight the SHAPEGROUP attribute in the list.  In the Value field in the upper 
right hand of  the dialog box, click the drop down arrow and a list of  available shape groups will be 
shown as in the figure below.

Fig. 9 - Shape Group list in the Attribute dialog box

The default SHAPEGROUP attribute value is appropriately enough Default.  Default will use the Shape 
Group Priority list within the Properties dialog box of  the schematic.  This feature will be discussed 
more in the next section.

When one of  the other shape group entries in the list is selected, the resistor will use the corresponding 
shape that was defined for that group in the Component Editor.

For our example, if  VarComp is defined for the SHAPEGROUP attribute, then that instance of  the 
resistor will use the Var_resist shape in the schematic.  Other instances of  the resistor in that schematic 
will not be affected by this change.
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Changing shape group priority
When a component has its SHAPEGROUP attribute defined as Default, it will use the Shape Group 
Priority list to determine which shape it will display in the schematic.  The Shape Group Priority list 
is available under the View tab in the Properties dialog box for the schematic.  The dialog box is dis-
played below:

Fig. 10 - Shape Group Priority list in the Properties dialog box

The Shape Group Priority list presents a list of  all of  the available shape groups.  Shape groups can have 
their priority changed by selecting the group in the list and then clicking the up arrow icon to increase 
the priority or the down arrow icon to decrease the priority.  Each component will start its search at 
the top of  the list.  If  the component has a shape defined within the first shape group, then it will use 
that shape.  If  it does not have a shape defined within that group, it will proceed to the second shape 
group.  If  it does not have a shape defined within the second group, it will proceed to the third shape 
group.  It will continue in that manner until it finds a shape group that it has a shape defined within.  
Since Main will always have a shape defined for every component, any shape group below Main in the 
list will never be accessed.  Any component that has had its SHAPEGROUP attribute modified so it 
uses a specific shape group will not be affected by any changes in this dialog box.

Changing the priority in the Properties dialog box will only have an effect on that specific circuit.  To 
change the shape group priority for new circuits, go to the Options menu and select Default Proper-
ties For New Circuits.  Click on the Schematic tab in the upper row and the View tab in the lower row.  
The list is available to edit here in the same manner as the standard Properties dialog box.  This will 
set the default priority whenever a new schematic is created.

To see how the priority can modify a circuit, load the file Diffamp.cir.  Double click in an empty area of  
the schematic or hit F10 to invoke the Properties dialog box.  Click on the View tab.  Select the Euro 
shape group and hit the up arrow button until it is listed as having the highest priority.  Click OK.  The 
Diffamp circuit now appears as in Figure 11.
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Fig. 11 - Diffamp.cir with the Euro shape group having the highest priority

Nearly all of  the components in this schematic have a shape defined within the Euro shape group.  Since 
Euro now has the highest priority, these components will use the corresponding European shapes in 
the schematic.  The Pulse Source is the only component that does not have a shape defined in the Euro 
shape group.  It continues to use the standard pulse source shape defined in the Main shape group.
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Product Sheet

Latest Version numbers
Micro-Cap 9..........................................................................Version 9.0.1
Micro-Cap 8..........................................................................Version 8.1.3
Micro-Cap 7..........................................................................Version 7.2.4

Spectrum’s numbers
Sales........................................................................................(408) 738-4387
Technical Support................................................................(408) 738-4389
FAX .......................................................................................(408) 738-4702
Email sales.............................................................................sales@spectrum-soft.com
Email support.......................................................................support@spectrum-soft.com
Web Site.................................................................................http://www.spectrum-soft.com
User Group...........................................................................micro-cap-subscribe@yahoogroups.com
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